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What is HQ Software

Free desktop software tool for 
• Reporting

– video, 
– audio, 
– pictures, 
– text 

• Organizing and editing inspection jobs, 
• Storing customer information, 
• Customizing and distributing reports in multiple formats, 
• Updating Equipment Software.

– E.g.: Current SeeSnake products and Legacy products
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What is HQx Live App?

Mobile app For SeeSnake CSx Monitors
• Share inspection media 
• Stream to a Second screen (mobile device) 
• Capture and share photos 
• PhotoTalk™ media, and video.

HQx Live connects via 
• Wi-Fi 

– Available functions: Streaming, Capturing Media (photos, 
videos), Remotely Control the Monitor Functions 

• Bluetooth
– Available functions: Remotely Control the Monitor Functions
– Maintain a separate Wi-Fi connection for data transfer
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HQ requirements 

• Operating System: Windows 7, Windows 8, Windows 8.1, Windows 10.
– Intel® Core i5 or AMD equivalent or higher. 1.84 GHz  (2.4 GHz or higher recommended)

• Memory: 2 GB system memory (4 GB or higher recommended)
• Graphics: DirectX 9/10/11 compatible graphics integrated/dedicated with 256MB or 

higher (512 MB or higher dedicated graphics card recommended)
• Sound: DirectX 9 or higher compatible sound card
• Storage: 30 GB of disk space
• Data Transfer: 1 USB 2.0 port (USB 3.0 or USB Type-C Optional)
• Screen: Screen resolution of 1024×768 (1280×800 or higher recommended)

Optional:
• Internet connection for emailing reports, uploading reports to YouTube, Google Drive, 

DropBox, and software updates.
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Downloading & Installation

• HQ Software is delivered on a USB, included with every new monitor
and reel. 

• HQ Software is downloadable for free from the official Support website
– http://support.seesnake.com/hq-for-pcs/
– Download: http://updates.seesnake.com/SeeSnakehq/SeeSnakehq.exe
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Downloading & Installation

• Opens the SeeSnake HQ Setup wizard
– Step 1: Accept the End-User License Agreement
– Step 2: Choose Destination Folder

• [Default in Program Files folder]
– Step 3: Ready to Install SeeSnake HQ
– Step 4: Connect your device to the computer
– Step 5: Add your Regional Settings

• Language, Video Standard, Display units, …
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Updating HQ Software

Software Updates for HQ are IMPORTANT
• Latest versions: Enhancements, Bug Fixes, Improved Functionality.
Automatic Software Updates
• HQ checks software updates automatically
• updater prompt asks to install updates (permission required)
• Internet Connection is required.
Manual Software Updates
• Via “Updates” Menu in the topheader.
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Updating SeeSnake Equipment

icon next to your SeeSnake equipment indicates a software update is 
available or via Alerts in the Notification area to alert you that an update 
can be downloaded.
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Updating SeeSnake Equipment

To update the software on your SeeSnake device using HQ:
1. Click “updates” button in Top Menu

(You must be connected to the internet to download the update.)

2. Select your device type and model from the drop down list and 
Insert a USB thumb drive/flash drive into your computer.

3. Follow the on-screen instructions, and choose the drive location to 
download and extract the update to.

4. Once downloaded, simply insert the USB thumb drive into the 
SeeSnake Equipment, power it up and agree to install the update 
when it prompts you.

The process will take a several minutes and your device may reboot a 
few times before it is complete.
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Terminology: Job

• Is a container for all the information related and necessary to create an 
inspection report

• Are automatically assembled from photos and video clips taken from 
SeeSnake pipe inspection equipment. 

• Can include video, still-pictures, Autolog video, and Photo Talk, 
• Includes location/customer information and text notes. 
• Distribution methods include YouTube uploads, E-mail, DVD, USB 

drive, print, and webpage reports.

Two Line, EXTERNAL Blue Tombstone
Text is 20pt, Bold and Title Case
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Home Window

The Home Window
• The first screen you see when opening HQ 
• Will serve as the main software hub for all your inspection jobs, 

equipment, and notifications. 
• Access to settings, menus, and sub-menus 

Home Window is your hub for all jobs, equipment and settings, …
Emerson Confidential and Proprietary/For internal use only
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Home Window

Home Window is your hub for all jobs, equipment and settings, …
Emerson Confidential and Proprietary/For internal use only

Navigation 
& 
Equipment 
menu

Main list of all current & new jobs

Job specific menuMain menu Settings menu
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Menu’s

• File Menu: Used to access and manage your HQ Jobs.
• Edit Menu: Move, manipulate, copy, mark read/unread and filter your Jobs.
• Tools Menu: Access settings, contacts and troubleshooting tools.
• Updates: Click to update HQ or your the software on your SeeSnake equipment.
• Help Menu: Used to get help, send bug reports and check for software updates.

• New Button: Creates a new job.
• Open Button: Opens an existing job that is selected.
• Archive Button: Moves the selected job to the “Job Archive”.
• Delete Button: Moves the selected job to the “Job Recycle” Bin.
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Menu’s

• The name of your computer: This is next to the HQ logo and can be 
changed.

• External drives: If USB flash drive is plugged in and recognized will appear.
• Job Space: This is a list of locations where your jobs are kept, archived, or 

recycled.
• Available Connections: When you connect the laptop to the Wi-Fi of the 

monitor, you can live stream, record the images the monitors displays.
• Equipment Locker: This lists any equipment that you have registered or used 

with HQ.
• Notifications: This is the area that gives you information regarding jobs, 

equipment, or errors.
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Menu’s

• Sign In Button: After registering (click sign up or register), Sign In to your HQ account.
• Updates: Click to update HQ or the software on your SeeSnake equipment.
• Contacts: You can add and save contacts, customers, and inspectors.
• Search: Use this to search for jobs, customers, and contacts.

– When you search for jobs, results are opened in “search results”
– To go back to the main list, by clicking “Jobs”

• Settings: Opens the settings menu
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Settings Menu

Emerson Confidential and Proprietary/For internal use only

• Preferences: Language, Distance, and 
General Settings.

• Job: Change job import and naming 
preferences.

• Video: Playback and Recording Settings.
• Overlay: Placement and Preferences for 

Video Overlay.
• DVD: Colors, Custom Intros, and 

Regional Preferences.
• Email: Configure email preferences to 

send reports via email.
• Equipment: Edit Account info, Sign 

in/out, Add Equipment, or reset 
password.
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Configure Email

– For distributing reports via email, directly from HQ.
– Choose the desired Email Type & fill in the required data.
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Home Window

• Job Columns and Status: Useful to see job status, sort jobs, and 
select jobs.
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Functions

• Create a new job: Select File > New, or click “New Job” Button.
• Import a job: Put a USB flash drive in your PC containing jobs from SeeSnake camera reel monitors, 

HQ will import the jobs automatically.
• Select a job: Click checkbox of the desired job (far left of the main list table), 

The selected job will be highlighted.
• Open a job: Select File > open job, or click “Open” Button, or double-click a job from the main list.
• Archive a job: Select the job and click “Archive” Button. Job is removed from the main list and 

placed in archive menu. 

• Delete a job: Select job and click “Delete” Button. This will not permanently delete the job, but moves 
it to “Job Recycle” by default.

• Recycle a job: When jobs are deleted, they are moved to “Job Recycle”. These jobs can be restored 
or permanently deleted.

• Sort Jobs: You can change the sort order of your jobs by name, date, customer, etc. by clicking the 
categories on top of the home window where the list of your jobs appear.
– alphabetically AZ or ZA by clicking on the column header which you want to sort.

Emerson Confidential and Proprietary/For internal use only



23

Main list

Right click on a job, to have added functionality
• Customize the Table Columns by right clicking on 

the header and select « Show/Hide Column
Headers »
– Hit « Restore Column Header » to change them back to 

HQ’s original settings.
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Main list

• Open, Rename, Delete or Archive Jobs
• « Export Job Media » if you quickly want to store the media to a 

different location or to a driver, without creating a report.
• « Mark as unviewed » to mark a job for later work
• Copy & Paste for fast duplication of jobs
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Main list

• Easily rename job name, by right clicking on the job you want to change and select « Rename Job »

Emerson Confidential and Proprietary/For internal use only

Easily rename or add data to job media

• Right click on the job you want to change 
and select « Rename Job media »

• In a separate screen you can now modify
or add new info.
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Home Window: Job Preview

Emerson Confidential and Proprietary/For internal use only

Job selected

The details/preview area show the media elements in the 
selected Job.
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Home Window: Job Preview
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• Right-click on a media element to email or copy and paste it into a document. 
• Hit Ctrl to select multiple media elements. 
• To collapse or expand the details pane, click on it.
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Streaming Video with HQ

In order to view live video on your computer/device coming from a WI-FI 
enabled SeeSnake Monitor, they must be connected via WI-FI.

The steps below show you how to connect your computer/device to a CSx
monitor via WI-FI to stream video with the Windows HQ software.

Steps
• Go into your CSx monitor WI-FI settings and verify WI-FI is turned on, 

and it is in host mode in order to connect to your computer/device.
• In your computer/device settings, go to the WI-FI settings and select your 

Ridgid CSx monitor from the list of WI-FI choices. Usually this is named with 
the model of your CSx monitor. 
– It is normal for your computer/device to say “Connected, no Internet” when you’re 

connected to the CSx.

• In HQ, open a new job and choose your CSx monitor from the SeeSnake 
Live drop-down list in the top left corner.

• You should now be able to view live video from HQ.
• If there is no live streaming CSx monitor or Ridgid LT1000, an option to 

“Stream Live Video… ” is auto-selected.
If you are using an Android or iOS/Apple mobile device for video streaming, use the HQx Live 
mobile app
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Job Window

Open a job by
• Double-click on the desired job or
• Tick checkbox of desired job and click “open” in job menu 
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Job Window

Job Navigator (on the left)

• Media you select in the Job Navigator is accented in blue and appears 
enlarged in the View Port to the right.
– View Port: This is where you view, edit, annotate

Emerson Confidential and Proprietary/For internal use only
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Job Window

Emerson Confidential and Proprietary/For internal use only

Connect webcam and / or microphone for adding PhotoTalk TM or 
commentary to your reports.
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Job Navigator
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Job Navigator

1. SeeSnake Live: Connect CSx Monitor, Webcam and/or Microphone. 
SeeSnake Live will expand to show a live feed from whatever camera is 
selected.

2. Job Data: Selecting the Job Data will make the “Job Information” the active 
element and place it in the View Port for you to edit. You can also change 
the media sorting by time/distance, or change the units with the 
corresponding buttons. 

3. Session Data: Selecting the Session Data will make the “Session 
Information” active and place it in the View Port for you to edit. Session 
Data is information you want included in reports for your customers.

4. The new Video Report tab allows you to compile videos, Autolog videos, 
photos, and PhotoTalk™ media into one video that can be uploaded to 
YouTube and supported Cloud services, or burned to USB. 

Emerson Confidential and Proprietary/For internal use only
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Job Navigator

4. Media List: Any media you capture while doing 
an inspection will appear in the “Media List”. 
Active media is highlighted in blue and enlarged 
in the View Port to the right. Right-clicking 
anywhere on media in the list will show the Media 
Options drop-down menu.

5. Job Information: Name the job and edit basic 
information related to the job.

6. Job Customer Information: Complete the 
customer fields, such as address and contact 
info.

7. Job Inspector Information: Fill-in the inspector 
business and contact info.

*Note: The job and session information can also be edited in 
the report tab of HQ.
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View Port [Edit mode]

Emerson Confidential and Proprietary/For internal use only
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View Port [Edit mode]

Emerson Confidential and Proprietary/For internal use only

Type of Media; 
Photo, Video, Autolog video, PhotoTalkTM; recognized by 
the corresponding icon

If these icons are shown, a text is inputted in the 
corresponding text boxes.
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View Port [Edit mode]

Emerson Confidential and Proprietary/For internal use only

Add PhotoTalkTM to the active media: only possible to add to a picture. A 
microphone is required to record your voice with the PhotoTalk.

Photo Editor: The Photo Editor can be used to enlarge, rotate, change 
brightness/contrast, add captions, and change colors to pictures.
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View Port [Edit mode]
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Create Snapshot from a video.

Clip editor: You can make a custom selection, if you don’t want to include the 
whole video, but pinpoint a part of the clip.
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Creating And Editting Job Reports

A Job Report in HQ is the output of a finished inspection Job. 
• Summarizes the information that may be useful for distribution
• Reports can include text, pictures, and video. 
• Three types of Job Reports in SeeSnake HQ

– Standard Report: To export, email, or print reports.
– DVD Report: To burn a Job Report onto a DVD.
– Upload Report: To upload your reports for online viewing.

Emerson Confidential and Proprietary/For internal use only
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Creating And Editting Job Reports

• Select in « Job navigator » the 
required files to include into the report 
by checking or unchecking the box

• Or You can control the visibility of 
media in the report tab.
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Creating And Editing Job Reports

In the report tab you can fully customize your report.
• Include a custom logo or picture on the top of the report.
• Change the colors of backgrounds, borders, fonts, titles, headers, and borders.
• Change the horizontal alignment of items like text and pictures.
• Change the size of fonts and pictures.
• Change the visibility of any group of data, element, or section to include or exclude it 

from the report.
• Edit the report text and notes from within the report template.
• Create and save report formatting styles for future use, so you can re-use your preferred 

report formatting and not have to modify the default style every time.
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Creating And Editing Job Reports

The Custom Job Reports Toolbar
1. Choose a Job Report Style: Pick one of the default styles, 

or one that you created previously 

2. Save Style Button: Save a Job report style that you 
created for re-use later

3. Style Editing: Click the Style Editing button to bring up the 
Style Editing Toolbar.
» From the toolbar you can change the colors of backgrounds, 

borders, fonts, titles, headers, and borders.

Emerson Confidential and Proprietary/For internal use only
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Creating And Editing Job Reports

Job Report Formatting Toolbars
• The report is made up in sections

– Header, Main Title, Contact Information, Date, Time, …
– Customize the entire section, toggle visibility on/off 

1. Show or Hide the Job location address.

2. Show or Hide the customer address.

3. Show or Hide the inspector address.

4. Align the elements to left, middle, or right.

5. Change the border visibility in the report.

Emerson Confidential and Proprietary/For internal use only
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Creating And Editing Job Reports

Job Report Formatting Toolbars
• Within some sections there are sub-sections

– Location, Customer info, Inspector Info,…
– Customize the specific info, toggle visibility on/off 

1. Show or Hide the Contact Company address.

2. Show or Hide the Contact First & Last Name.

3. Show or Hide the Conact Email Address.

4. Show or Hide the Conact Phone Numbers.

5. Change the visibility of the Label text.

Emerson Confidential and Proprietary/For internal use only
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Creating And Editing Job Reports

Job Report Formatting Toolbars
• The report is made up in sections

– Header, Main Title, Contact Information, Date, Time, …
– Customize the entire section, toggle visibility on/off 

• Within some sections there are sub-sections
– Location, Customer info, Inspector Info,…
– Customize the specific info, toggle visibility on/off 

1. Change the visibility of the group of data, element, or 
section to include or exclude it from the report. 

2. Change the font size for the group of data, element, or 
section.

3. Align the elements to left, middle, or right.

4. Change the visibility of the element label text to include or 
exclude it from the report.

5. Change the border visibility in the report.

Emerson Confidential and Proprietary/For internal use only

1 2

543



49

Job media

• Job media can be
• E-mailed
• Uploaded to a private youtube link (requires google account)
• Uploaded to a dropbox account
• Uploaded to a google drive account

Emerson Confidential and Proprietary/For internal use only
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Standard Job Reports
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1. PDF-format
• Includes text, pictures

2. Webpage (HTML)
• Includes Text, pictures, video

and PhotoTalk
• Opens locally or from a USB 

drive in a web browser.

Standard: Standard Reports can be 
emailed, printed, or exported as 
PDF/HTML. 

This type of report either encapsulates 
content as a PDF document, or it 
develops a web page in HTML format, 
to assist in the viewing of the Job 
content, including video.
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Standard Job Reports: HTML Report

Emerson Confidential and Proprietary/For internal use only

Create the HTML-report 
by choosing in the export-
screen for File-type: 
webpage
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Standard Job Reports: HTML Report

• Export as a Webpage will create a map and .html file is the designated
folder.

Emerson Confidential and Proprietary/For internal use only

Click on the images in 
the HTML-file to open 
the video.
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Standard Job Reports: Email & Print

» E-mail your job reports in PDF Format direct from HQ

» Configure e-mail via « settings » menu

» Print your job reports

» Will prompt the Print command on your PC
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Video Job Reports

VIDEO
• Collects the Job information and converts it to a combined video
• Useful for report distribution and archiving reports and videos.

Emerson Confidential and Proprietary/For internal use only

Create a video report
• Open a job in HQ and go to the Video Report tab.
• Drag and drop items of media from the left hand column to the blank area below the playback window.
• Multiple media items can be combined into one video report. The media in the video report can 

include video, photos, Autolog, and PhotoTalk™ media.
• You can select the media that you dragged to the video report and use the playback controls to 

preview.
• You can change the duration of the intro slide and pictures by hovering over the slide, and using the 

up or down arrows to adjust the duration.
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Upload Video Reports

Upload a video report
• When you are finished selecting and previewing the media, select Create Report or Create and 

Upload, and select your upload destination (YouTube, Dropbox, Google Drive).
• Your video report will now appear in the Edit tab of HQ and will also be uploaded to your chosen 

destination.
• Once the video is uploaded, you can email a link to it by clicking the Email button in the Edit tab.
• For information about uploading HQ media to YouTube, please see the YouTube Support Page.

NOTE: You must authorize the upload destination to work with HQ. The authorization process is similar for all services. 
To learn more, please see the Authorization Support Page.
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Upload Job Reports (RIDGID Connect)

Upload
• Requires RIDGIDConnectTM login

– Choose to upload report or media only.
– Select media via “job navigator”

RIDGIDConnect™ is the online solution that streamlines your reporting process, integrates digital media and files into a 
hosted archive environment, and makes professional reports that you can share with anyone.
• RIDGIDConnect is mostly active for US-customers.
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Sending Bug Reports

Contact us!
• If you have a problem that you need help with or want us to know 

about 
– Contact Right from SeeSnake HQ. 

• Go to the Help Menu and select Send Bug Report

Help: 
– Online manual: http://support.seesnake.com/hq-online-manual/
– Download/Update for FREE: 

http://updates.seesnake.com/SeeSnakehq/SeeSnakehq.exe
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What is HQx

HQx Live 
• FREE app 
• Works with all Wifi / Bluetooth connected CSx

Monitors to share inspections media with 
customers. 

• For iOS and Android Phones / Tablets

Functions
• Streaming to second screen (Wi-Fi)
• Capture and share media.

– Quickly share with customer: Live stream or e.g. 
mail

– Keep quick track of jobs via the app. 
• Remotely Control the Monitor 
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Home 

1. Opens « Settings »
2. Opens « Remote Control »
3. Opens « Jobs »
4. WI-FI connection info
5. Opens device WI-FI settings
6. « Camera Options »

– Device Camera
– Front-facing Device Camera
– Reel Camera, streaming from

Connected Monitor (WIFI only)
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Connecting with Wi-Fi

1. Power on the CSx monitor.
2. In your device, open Settings and 

then Wi-Fi.
3. Touch the name of the CSx monitor 

in the list of available networks.
4. The CSx network says “Connected, 

no Internet” when you’re connected.

While connected to a CSx monitor over Wi-Fi, a device 
may not be able to send and receive data. Some 
devices can send and receive data over a cellular 
network. Messaging and data rates may apply.

Emerson Confidential and Proprietary/For internal use only
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Connecting with Bluetooth

1. Power on the CSx monitor.
2. In your device, open Settings and 

then Bluetooth.
3. Tap the name of the CSx monitor in 

the list of available devices.
4. Follow the prompts on your CSx

monitor and mobile device.
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Menu’s

• Settings Menu
– Information

• App version, storage
info & Wi-Fi Connection

– Permissions (app)
• Location
• Camera
• Microphone

– Settings
• Panel Auto-Hide
• Recycle Bin settings

– Recycle Bin
• Access to recycle bin

– Support
• Links to 

SeeSnake Support
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Remote Control

• Using HQx to remote control the CSx Monitor
– The remote control offers the same functions as 

the monitor (except power on/off)

– Connect two devices simultaneously
• Via Bluetooth to Remote Control the monitor
• Via Wi-Fi to Stream inspections

Steps
1. Connect your CSx monitor to a SeeSnake camera reel.
2. Connect your mobile device to your CSx monitor over 

Bluetooth or Wi-Fi. 
3. Open HQx Live and tap the      camera reel icon to 

open the Reel Controls screen.
4. Use the icons on the Reel Controls screen the same 

way as you would on a CSx monitor.
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Manage Jobs

• Important: Jobs on HQx Live app are NOT synchronized with Jobs 
active/stored on the monitor.

1. Job Navigator
2. Create a New Job
3. Share Media from

Selected job
4. Remove Media to 

Recycle Bin
5. Remove Job to

Recycle Bin
6. Recover media from

Recycle Bin
7. Media Navigator
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Streaming 

1. Connect your CSx monitor to a SeeSnake camera reel.
2. Connect HQx Live to the monitor over Wi-Fi.
3. Tap on the arrow       to open “Camera Options”
4. Tap in “Camera Options” to switch between your mobile device’s rear-facing camera, 

front-facing camera, and the camera reel.
5. When you’ve switched to the camera reel, footage from your CSx monitor displays on 

your mobile device’s screen. 
6. You can now capture media 

directly onto your mobile device.

Note: The media captured on your mobile device via HQx
is NOT synchronized with the captures on the monitor.

• You can capture the following media 
types from a SeeSnake camera reel 
or your device’s rear-facing and 
front-facing cameras: 
– PhotoTalk
– Photo
– Video
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Streaming 
Note: The media captured on your mobile device via HQx is NOT synchronized with the captures on the monitor.

• You can capture the following media types from a SeeSnake camera reel or your device’s 
rear-facing and front-facing cameras: 
– PhotoTalk
– Photo
– Video

1. Tap the media-type you want to capture
2. Tap the check mark to complete the capture.
3. Select whether to save the media to a new job 

or another job.
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Create / Edit a Job

Tap the Job Manager icon to open the Job Manager.

To Create 
1. Tap the New Job icon.
2. Fill out the information and tap Done. You have the option of giving the job a custom 

name. (If no name is entered, the job will be named according to the date and time it was created.)

3. When a new job is created, it becomes the open job.

To Edit: 
1. Tap the Edit Job icon.
2. Change the info and tap Done.
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Opening / Closing a Job

Tap the Job Manager icon to open the Job Manager.
• Open jobs are highlighted in a red border. 

– There can be only 1 open job
• Media is automatically saved to the open job.
• To Close: Tap the “Close Job” icon.
• To re-open a job, tap      in the job

you want to open. 
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Deleting Jobs / Media

Tap the Job Manager icon to open the Job Manager.

• Deleting a Job
1. From the Job Manager, swipe left and right at the bottom of the screen to select the 

job you want to delete.
2. Tap Remove Job.
3. Select “Move Job” in the prompt 

that appears.

• Deleting Media
1. Swipe between individual media 

captures to select the media you
want to delete.

2. Tap the Trash icon.
3. Select “Move Media” in the 

prompt that appears.
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Restoring Jobs / Media

Tap the Job Manager icon to open the Job Manager.

• Recovering Media / Jobs
1. Tap the Recycle icon.
2. Opens “Deleted Media” 
3. Tap               to restore media 

back into the originating job
4. Tap               to permanently 

delete media
5. Tap                 to permanently 

delete all media

Note: media in the recycle bin will be 
automatically deleted in 30 days.
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Sharing media

• You can share media during capture or from the job manager.
If you are connected to your CSx monitor over Wi-Fi, your media 
can be shared over a cellular network. Messaging and data rates may apply.

• Share media over Wi-Fi, go to Settings, select Wi-Fi, and choose 
the network you want to connect to. 
This will disconnect your device from the CSx monitor.

From Job Manager
1. Tap the “Share” icon in the Job Navigator or in the 

Media Preview.
(iOS) or (Android) 

2. Select the media you want to share
3. Tap the “Share” icon in the upper right corner.
4. Choose how you want to share the selected media.

(different options apply when using iOS or Android)
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Sharing media

During Capture (iOS only)

1. Tap the icon for the media you want to capture.

2. Tap the Share icon.

1. Choose how you want to share the selected media.
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Need extra Support?

SeeSnake HQ Software
• Download latest version

– http://support.seesnake.com/hq-for-pcs/

• Online Manual HQ Software
– http://support.seesnake.com/hq-online-manual/

• How-to video’s on HQ Software
– https://youtu.be/WPr7gNOZjbw?list=PLr8pgvXiOx-

rwrqU8ZIOVEyifsxvCIDU7

HQx Live app
• Download for Android

– https://itunes.apple.com/us/app/HQx-live/id1103321719?mt=8

• Download for iOS
– https://itunes.apple.com/us/app/HQx-live/id1103321719?mt=8

• Online help on HQx
– http://support.seesnake.com/HQx-live-mobile-app/

RIDGID Support

www.ridgid.eu

Contact Sales Manager:

Name 
Contact details


